SAFETY INSTRUCTIONS
1. Depressurize and vent system prior to installation or removal.
2. Confirm chemical compatibility before use.
3. Do not exceed maximum temperature/pressure specifications.
4. Wear safety goggles or faceshield during installation/service.
5. Do not alter product construction.

1. Description

The 2551 Magmeter measures the flow rate in a full pipe by monitoring the voltage produced when the (conductive) fluid moves through a magnetic field. Output options include a traditional frequency signal, a serial data (Digital (S3L)) output, and a 4 to 20 mA output.

The 2551 Magmeter is available in three sizes that will accommodate pipes from ½-inch through 36-inch diameters.

Select from three different material combinations to match the Magmeter to the application requirements.

Contents

1. Description 1
2. Specifications 2
3. Installation: Pipe fittings 3
   3.1 Installation: Selecting a Location 3
4. Overview of 2551 Display versions 4
5. Wiring 5
   5.1 Basic Wiring 5
   5.2 Wiring: Mirror Relay 1 output 5
   5.3 2551 and other manufacturer’s instruments 5
   5.4 Wiring to Signet Flow Instruments 6
   5.5 Wiring Relays 7
6. View Menu 8
   6.1 Resetting the Resetable Totalizer 8
   6.2 Navigating the Menus 9
   6.3 Keypad Functions 9
   6.4 Security Code 9
7. Setup Menu 10
   7.1 Averaging and Sensitivity 11
   7.2 Bi-Directional Flow 12
   7.3 Calibration Data 12
8. Calibration Menu 14
   8.1 Volume method of calibration 14
   8.2 Rate method of calibration 14
9. Relay Menus 15
   9.1 Pulse Relay mode 15
   9.2 Total Relay mode 15
   9.3 High, Low, or Window Relay modes 16
10. Test Menu 17
11. Options Menu 17
   11.1 Output Modes 17
12. Technical Information 18
   12.1 Grounding 18
   12.2 Maintenance 19
   12.3 Troubleshooting 19
13. Ordering Information 20

WARNING!

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY RESULT IN THE SENSOR BEING EJECTED FROM THE PIPE!

• DO NOT USE ANY TOOLS ON THE RETAINING CAP. HAND TIGHTEN ONLY.
• LUBRICATE O-RINGS WITH A NON-PETROLEUM BASED, VISCOUS LUBRICANT (GREASE) COMPATIBLE WITH THE SYSTEM.
• DO NOT USE THREAD SEALANT OR LUBRICANTS ON THE RETAINING CAP OR ON THE PLASTIC FITTING THREADS.
• IF LEAKING IS OBSERVED FROM THE RETAINING CAP, IT INDICATES DEFECTIVE OR WORN O-RINGS ON THE SENSOR. DO NOT ATTEMPT TO CORRECT BY FURTHER TIGHTENING.

Do not use any tools to tighten the yellow retaining cap. DO NOT USE thread sealant or lubricants on retaining cap!

Lubricate O-rings with a non-petroleum based, viscous lubricant (grease) compatible with the system.

DO NOT USE thread sealant or lubricants on the fitting threads!
2. Specifications

General
- Pipe size range: DN15 to DN900 (1/2 to 36 in.)
- Flow Range Minimum: 0.05 ms (0.15 ft/s) (Bi-directional) Maximum: 10 ms (33 ft/s)
- Linearity: ±1% of reading +0.01 ms (0.033 ft/s)
- Repeatability ±0.5% of reading @ 25 °C (77 °F)
- Minimum Conductivity: 20 μS/cm

Wetted Materials:
- Sensor body and Electrodes and Grounding ring:
  - P0, -P1, -P2: Polypropylene and 316L SS
  - T0, -T1, -T2: PVDF and Titanium
  - V0, -V1, -V2: PVDF and Hastelloy-C
- O-rings: FPM (standard) EPDM, FFPM (optional)

The user is responsible for determining the chemical suitability of these materials for a specific application.

Power Requirements
- 4 to 20 mA: 21.6 to 26.4 VDC, 22.1 mA max. 400 mV p-p maximum ripple voltage
- Frequency: 5 to 26.4 VDC, 15 mA max.
- Digital: 5 to 6.5 VDC, 15 mA max.
- Auxiliary (only required for units with relays): 9 to 24 VDC, 0.4A max
- Reverse polarity and short circuit protected

Output Specifications
Current output (4 to 20 mA)
- Max Loop Resistance: 300 Ω
- Loop Accuracy: 32 μA max. error (25 °C @ 24 VDC)
- Temp. drift: ± 1 μA per °C max.
- Power supply rejection: ± 1 μA per V
- Isolation: Low voltage < 48 VAC/DC from electrodes and aux power
- Maximum cable: 300 m (1000 ft.)
- Error condition: 22.1 mA

Frequency output:
- Output modes: Freq, Freq÷10, or Mirror Relay 1
- Max. Pullup Voltage: 30 VDC
- Max. Current Sink: 50 mA, current limited
- Maximum cable: 300 m (1000 ft.)
- Reverse Polarity Protected to -40 V

Digital (S^L) Output:
- Serial ASCII, TTL level 9600 bps
- Compatible with Signet 9800 and 9900

Relay Specifications
- Relay 1 and 2 Type: Mechanical SPDT
  Rating: 5 A @ 30 VDC max., 5 A @ 250 VAC max.
- Relay 3 Type: Solid State
  Rating: 50 mA @ 30 VDC, 50 mA @ 42 VAC
- Hysteresis: Adjustable, plus timer delay
- Trigger Delay: Adjustable (0 to 9999.9 sec.)
- Relay Modes: Off, Low, High, Window, and Proportional Pulse
- Relay Source: Flow Rate, Resettable Totalizer
- Error Condition: Selectable; Fail Open or Fail Closed

Display
- Characters: 2 x 16
- Contrast: User-set in four levels
- Backlighting (only on relay versions): Requires external 9-24 VDC, 0.4 mA max.

Environmental Requirements
- Case: PBT
- Display window: Polyamide
- Storage Temperature: -20 to 70 °C (-4 to 158 °F)
- Relative Humidity: 0 to 95% (non-condensing)
- Operating Temperature
  - Ambient: -10 to 70 °C (14 to 158 °F)
  - Media: 0 to 85 °C (32 to 185 °F)
  - Max. operating pressure: 10.3 bar @ 25 °C (150 psi @ 77 °F)
  - 1.4 bar @ 85 °C (20 psi @ 185 °F)

Standards and Approvals
- CE
- UL, CUL (for display versions with relays)
- NEMA 4X / IP65 Enclosure (with cap installed)
- China RoHS

For more information go to www.gfsignet.com

Declaration of Conformity according to FCC Part 15
This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and,
(2) This device must accept any interference received, including interference that may cause undesired operation.

Dimensions

Pipe Range
1/2 to 4 in. -X0 = 58 mm (2.3 in.)
5 to 8 in. -X1 = 91 mm (3.6 in.)
10 to 36 in. -X2 = 167 mm (6.6 in.)

X = Sensor Body P, T, or V

Operating Temperature/Pressure

![Operating Temperature/Pressure Chart](chart.png)
3. Installation: Selecting a Location

- The 2551 requires a full pipe and a fully developed turbulent flow profile for accurate measurement.
- If the piping system harbors air pockets or bubbles, take steps to locate the sensor so the air pockets will not contact the electrodes.
- In vertical installations, assemble the 2551 so the conduit ports are facing downward. This prevents condensation inside the conduit from being directed into the 2551 electronics housing.
- Chemical injection systems can temporarily alter the fluid conductivity and cause anomalies in the magmeter measurement. To avoid this problem, install the magmeter upstream of the injection point.

Select a location with sufficient distance of straight pipe immediately upstream of the sensor.

Locating the sensor in a trap or where the flow is upward helps to protect the sensor from exposure to air bubbles when the system is in operation.

3.1 Installation: Pipe Fittings

Georg Fischer offers a wide selection of installation fittings that control the position of the Magmeter electrodes in relation to the dimensions of the pipe. You will find a complete list of order numbers for installation fittings in the Calibration Tables on pages 12-13.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Plastic tees        | • 0.5 to 2 inch versions  
                        | • MPVC or CPVC                                                              |
| PVC Glue-on Saddles | • Available in 10 and 12 inch sizes only  
                        | • Cut 2-1/2 inch hole in pipe  
                        | • Weld in place using solvent cement                                      |
| PVC Clamp-on Saddles| • 2 to 4 inch, cut 1-7/16 inch hole in pipe  
                        | • 6 to 8 inch, cut 2-1/8 inch hole in pipe                                |
| Iron Strap-on saddles| • 2 to 4 inch, cut 1-7/16 inch hole in pipe  
                        | • Over 4 inch, cut 2-1/8 inch hole in pipe  
                        | • Special order 14 in. to 36 in.                                          |
| Iron, Carbon Steel, 316 SS Threaded tees | • 0.5 to 2 in. versions  
                        | • Mounts on threaded pipe ends                                              |
| Carbon steel & stainless steel Weld-on Welloets | • 2 to 4 inch, cut 1-7/16 inch hole in pipe  
                        | • Over 4 inch, cut 2-1/8 inch hole in pipe                                |
| Fiberglass tees      | • 1.5 in. to 2 in. PVDF insert                                              |
| Union Fittings and Wafers | • For pipes from DN 15 to 50 mm  
                        | • PP or PVDF                                                                |

In a gravity-flow system, the tank must be designed so the level does not drop below the outlet. This causes the pipe to draw air in from the tank. If air bubbles pass across the Magmeter electrodes, the output will become erratic.
4. Overview of 2551 Display Magmeter

2551 Display Magmeters use a dual-sided electronics module and dual conduit ports. Unused ports must be sealed to protect the electronics from water damage.

1. The lower set of conduit ports provide access to the wiring terminals for:
   - Loop Power
   - Flow Output Signal (current loop, Digital (S'L), frequency or Mirror Relay 1 output).

2. The upper set of conduit ports provide access to the wiring terminals for:
   - Relay output wiring
   - Auxiliary power for relay coils and display backlight

3. The sensor is marked with a directional arrow to indicate the direction identified as forward flow.
   - An adhesive decal is also provided that can be affixed to the pipe to indicate the direction of forward flow.
   - Flow in the opposite direction from the arrow will be identified as reverse flow on the display by a "-" symbol.

4. The terminals in the magmeter are designed to accommodate 16 to 22 AWG conductors.

5. The display includes two LEDs that light when Relay 1 or Relay 2 are activated.
   - All three relays can be monitored by scrolling to the Relay Status display located in the View menu.
   - If the Language option has not been made, new magmeters will always open with the Select Language display.

6. The part number, serial number and output type are identified on the electronics module.

Chemical Compatibility Warning

The retaining nuts of Magmeters are not designed for prolonged contact with aggressive substances. Strong acids, caustic substances and solvents or their vapor may lead to failure of the retaining nut, ejection of the sensor and loss of the process fluid with possibly serious consequences, such as damage to equipment and serious personal injury. Retaining nuts that may have been in contact with such substances e.g. due to leakage or spilling, must be replaced.
5. Wiring

5.1 Basic Wiring

Frequency output

3-2551-21 and -41 Magmeters may be programmed in the OPTIONS menu to provide an open collector FREQUENCY output.

- The maximum frequency output is 1000 Hz (@ 10 meters per second)
- If the Frequency ÷ 10 output is selected, the maximum frequency is 100 Hz (@ 10 meters per second).
- AUX PWR must be connected to power the display backlighting and to power the relay coils if included.

4 to 20 mA output

The 3-2551-22 and -42 Magmeters provide a passive 4 to 20 mA loop output.

- External loop power (24 VDC) is required.
- Factory standard calibration is 4 - 20 mA = 0 - 5 m/s.
- The 4 to 20 mA output can be spanned to any range, from -10 m/s to +10 m/s.
- AUX PWR must be connected to power the display backlighting and to power to the relay coils if included.

5.2 Wiring: Mirror Relay 1 output

The 3-2551-21 and -41 Magmeter can be configured in the OPTIONS menu to provide an Open Collector output in lieu of the sensor signal provided by Frequency or Digital (S^3L) output selections. The Open Collector output can be programmed via the Relay 1 menu.

5.3 2551 and other manufacturer’s instruments

When using the 2551 in a system with other manufacturer’s equipment, a 10 KΩ pull-up resistor (not supplied) may be required to power the open collector output.
5.4 Wiring to Signet Flow Instruments

The 2551-21 and -41 Magmeter can be configured in the OPTIONS menu to provide a Frequency or Digital (S'L) output. Frequency output can be used by Signet 5600 Flow Transmitter, and by Signet 8900 Multi-Parameter Controller and 9900 Transmitter. The Digital (S'L) output can be used by the 8900 and 9900.

2551 Frequency Out to Signet 5600

2551 Frequency Out to 8900 Controller:

2551 Digital (S'L) Out to 8900 Controller:

2551 Frequency or Digital (S'L) Out to 9900 Transmitter:
Relay 1, Relay 2 Type: Mechanical SPDT
Rating: 5 A @ 30 VDC max., 5 A @ 250 VAC max

Relays 1 and 2 are dry contact relays rated for 5 A maximum current. They are best suited for switching high voltage loads, such as AC powered pumps and valves.

When used to switch inductive loads, dry contact relays may be damaged by arcing. Signet recommends the installation of a filter device to prevent such damage.

3-8050.396 159 000 617 RC Filter kit (for relay use)

Relay 3 Type: Solid State
Rating: 50 mA @ 30 VDC, 50 mA @ 42 VAC

Relay 3 is a solid state relay. It can be applied exactly the same as a dry contact relay, but the current rating is 0.2 A (200 mA) maximum. Relay 3 is best suited to pulse applications and low voltage loads.

Auxiliary power must be connected to operate the relays and to power the display backlighting. Auxiliary power is fully isolated. The Loop Power supply may be used for Aux power if the power source provides a sufficient current rating.

Application Notes: Relay Wiring

- Inductive relay loads may generate transient voltage spikes well in excess of the relay contact ratings. This will cause arcing across the contacts and consequently rapid relay wear. Signet recommends an RC-style filter (“snubber”), installed as illustrated here.
- The filter kit (3-8050.396) is available as an accessory item. See ordering information on back cover.
- Signet product warranty does not cover damage to relays due to contact burnout.

Definition:
An inductive load is an electrical device generally made of wire that is coiled to create a magnetic field to produce mechanical work when energized.

Examples of inductive loads include motors, solenoids, and relays.

High voltage transients from these types of loads can cause arcing across mechanical switching contacts or can cause damage to solid-state contacts.
6. View Menu

The VIEW menu contains all of the basic information available from the Magmeter.

- The normal operating display shows the FLOW RATE on the top line of the display and the Resettable Totalizer on the lower line of the display.
- The Right Prompt symbol (>) always indicates a sub-menu associated with the current display. In this display it points the way to the TOTALIZER RESET function. See section 6.1 for detailed instructions.
- With AUXILIARY power connected to the magmeters with Relays, the display will be backlit. There is no switch to turn the backlight off.
- A flashing character or text on the display indicates that the item is being edited. This manual uses a (red) star to illustrate a flashing display.
- The following information is viewed by scrolling ▲ or ▼. These displays will remain in the display for 10 minutes, then the normal operating display will return.

6.1 Resetting the Resettable Totalizer

1. From the normal operating display, press the ► key.
2. The resettable totalizer can be configured to require the security code before allowing the reset. If the Total Reset is set to "RESET OFF" this display will not appear. See section 11, Options Menu for instructions.
3. Press any arrow key to toggle the flashing selection from NO to YES.
4. Press the ENTER key. The totalizer will reset to all zeroes and the display will immediately return to the normal operating display.
6.2 Navigating the Menus

Normal Operation Display
The normal operating display shows the Flow Rate on the top line and the Resettable Totalizer on the bottom line.
• All menu instructions in this manual assume that the instrument is showing this display.

2551 Menu Directory
The 2551 Magmeter uses seven main menus to provide access to the calibration and programming features. Each menu serves a specific function.

Starting from the normal operating display, there are two ways to access the menus:
1. Press the ▲ key to scroll to the Enter Menu display, then press the ▼ key.
2. Press the ENTER key and hold it for about three seconds.

Setup Menu
This menu contains all of the settings and information that the magmeter requires to operate, including the K-Factor, the totalizer settings, low flow cutoff, and several display characteristics. See section 7.0 for details related to this menu.

Calibration Menu
This menu provides two different methods for adjusting the calibration. See section 8.0 for details related to this menu.

Relay Menus
Each of the available relays in the 2551-21 and -22 are programmed from their own dedicated menu. See section 9 for details related to these menus. NOTE: Menu items associated with Relays 2 and 3 are suppressed in models without relays. See section 9.0 for details related to this menu.

Test Menu
This menu is used to manually toggle relays or to induce a known value out of the 4 to 20 mA terminals. See section 10.0 for details related to this menu.

Options Menu
This menu contains those settings and values that are usually programmed during the initial installation, and then seldom modified, including the SECURITY CODE (see section 6.4). See section 11.0 for details related to the Options menu.

6.3 Keypad Functions

▲ Scrolls UP through any menu.
If the display shows any flashing character or selection, scrolls UP to the previous value or selection.

▼ Scrolls DOWN through any menu.
If the display shows any flashing character or selection, scrolls DOWN to the next value or selection.

▲▼ Press the ▲ and ▼ keys together to abandon any unsaved edits and return to the previous display.

Opens the menu currently being displayed.
In Edit modes, advances the flashing character.
In menus with only two options (Yes or No, On or Off) toggles between selections.

ENTER Saves a new selection in any menu.
From Normal Operation display, jumps to first selection in Menu directory (when held for three seconds)

6.4 Security Code

The 2551 has a security code that can be programmed to any four-digit numerical value.
• The factory setting is 0-0-0-0.
• To program the security code go to the Options menu.
• The security code will be required to edit any of the items in the menus. It is required only once for each editing session.
• Record the custom security code here or in a safe location.
• If the security code is lost, contact your Signet service center for instructions.

Enter Code 0100

WRITE IT DOWN!
7. Setup Menu

The Setup menu contains all of the parameters necessary for the 2551 Magmeter to begin measuring flow.

NOTE: The Security Code must be entered before any changes can be made to the Setup menu. See the Options menu in section 11 for details.

Use the keypad to navigate through each setting.

The values shown for each menu item represent the factory standard setting. All 2551 magmeters are packaged with these settings.

K-Factor: See the charts in section 7.3 for values in pulses per U.S. gallon or in pulses per liter. To use other units, convert the published values as appropriate.

Pipe Size: Select the pipe size that is nearest to the nominal pipe size.

Flow Units: Set the units for the application. Four characters are available. The first three characters can be set to any symbol or alpha character, upper or lower case. The following special symbols are located between the upper case and lower case menus:

- (centered dot)  μ (micro)  (blank)
- (dash)   / (slash)  3 (for cubic units)

The last character selects the timebase for the flow rate measurement. Select S/s (seconds) M/m (minutes), H/h (hours) or D/d (days)

Set 4 mA: (2551-22 and -42 versions only) Set the flow rate where the current output will be 4 mA.

Set 20 mA: (2551-22 and -42 versions only) Set the flow rate where the current output will be 20 mA.

The 4 to 20 mA output may be spanned to monitor forward and reverse flow rates.

Total Factor: Set the factor by which the totalizer will count. This setting is made in the application units (i.e., gallons, liters, etc.)

Totalizer Units: Set the Totalizer Units. This setting serves as a label for the totalizer displays only. It has no effect on the measurement. The special characters listed in the Total Factor settings are available here also.

Low Flow Cutoff: Set a flow rate that the 2551 Magmeter will use as a minimum threshold. If the flow rate falls below this value, the 2551 will respond as if the flow were zero.

Averaging: Set the averaging period based on the installation and flow conditions. Smaller values allow the 2551 to respond to changes in flow rate quickly, while larger values smooth the fluctuations caused by installation and flow conditions. See section 7.1 for details.

Sensitivity: Set a percentage of maximum range by which the flow must change to override the averaging feature and "jump" quickly to the new flow rate. See detailed explanation in section 7.1.
7.1 Averaging and Sensitivity

Even the most carefully engineered flow systems may experience erratic and unstable conditions. If the instability is communicated to the output functions, the results may create problems for control devices.

To alleviate these issues, the 2551 provides two adjustments that operate in tandem. The information here will help in determining the appropriate settings for any specific application.

**Averaging**

- The AVERAGING setting dictates the time over which the magmeter will average the flow signal.

  The LCD display is updated every second. With averaging at 14 seconds, the flow rate on the display is an average of the previous 14 seconds input.

  Short averaging times provide the fastest display and output response to changes in the flow rate.

  Higher averaging times help to smooth the display and current output where the flow in the pipe is erratic or unstable due to installation limitations.

**Sensitivity**

- The SENSITIVITY setting determines how the 2551 responds to sudden surges in the flow rate. It "overrides" the Averaging function just long enough to allow an actual change in flow rate to be displayed, then resumes the averaging. The result is a smooth flow display and a quick response to large shifts in the flow rate.

  The settings for Sensitivity represent a percentage of the magmeter’s maximum range, or 10 milliseconds (ms).

  Example: A sensitivity setting of 25% means that the flow rate must change instantly and by more than 2.5 ms before the function is enabled.

**NOTE:** The SENSITIVITY function is ineffective if the AVERAGING function is set to zero.

---

**CAUTION**

The SENSITIVITY function changes the response characteristics of the magmeter. If used as part of a tuned closed loop control system, such a change may be undesirable.
7.2 Bi-Directional Flow
• The 2551 magmeter is designed to measure bi-directional flow.
• The forward flow direction is indicated by the directional arrow molded into the side of the 2551 sensor.
• The conduit ports are assembled at the factory to point UPSTREAM. They may be reversed by disassembling the components of the magmeter and reassembling.

Flow Rate Display: The "+" sign is suppressed during forward flow. 
*123.45 GPM* during reverse flow.

Totalizer Display: The totalizer will count during forward flow conditions only. During reverse flow the totalizer will not increment.

 Relay Outputs: May be set to detect reverse flow: "Low Setpoint at -25 GPM."

4 to 20 mA output: May be scaled to span any flow range: 
For example: "4 to 20 mA = -100 GPM to +100 GPM"

Frequency output, Frequency ÷ 10 output: Reverse flow is processed same as forward flow in the frequency output magmeters.

Digital (S/L) output: Reverse flow results in 0 flow rate output.
### 7.3 Calibration Data: K-Factors

#### Carbon Steel Tees and Weld-o-Lets

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
<tbody>
<tr>
<td>½</td>
<td>CS4T005</td>
<td>1572.66</td>
<td>415.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>¾</td>
<td>CS4T007</td>
<td>1086.73</td>
<td>287.11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CS4T010</td>
<td>582.34</td>
<td>153.86</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1¼</td>
<td>CS4T012</td>
<td>377.48</td>
<td>99.73</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1½</td>
<td>CS4T015</td>
<td>267.79</td>
<td>70.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CS4T020</td>
<td>167.85</td>
<td>44.35</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Stainless Steel Tees and Weld-o-Lets

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
<tbody>
<tr>
<td>½</td>
<td>CR4T005</td>
<td>1601.26</td>
<td>423.05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>¾</td>
<td>CR4T007</td>
<td>937.78</td>
<td>247.76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CR4T010</td>
<td>606.18</td>
<td>160.15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1¼</td>
<td>CR4T012</td>
<td>279.68</td>
<td>73.98</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1½</td>
<td>CR4T015</td>
<td>147.65</td>
<td>39.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CR4T020</td>
<td>111.90</td>
<td>29.56</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Galvanized Iron Tees

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IR4T010</td>
<td>558.50</td>
<td>147.56</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1¼</td>
<td>IR4T012</td>
<td>334.45</td>
<td>88.36</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1½</td>
<td>IR4T015</td>
<td>248.97</td>
<td>65.78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>IR4T020</td>
<td>146.00</td>
<td>38.57</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Bronze and Copper Tees and Brazolets

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
</table>
| BRONZE TEES ON SCH 40 PIPE
| ½             | BR4T010      | 582.34   | 153.86  |          |        |
| ¾             | BR4T012      | 330.54   | 87.33   |          |        |
| 1             | BR4T015      | 254.76   | 67.31   |          |        |
| 2             | BR4T020      | 157.36   | 41.58   |          |        |

COPPER TEES FITTING ON COPPER PIPE SCH K

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
<tbody>
<tr>
<td>½</td>
<td>CUKT005</td>
<td>2459.19</td>
<td>649.72</td>
<td></td>
<td></td>
</tr>
<tr>
<td>¾</td>
<td>CUKT007</td>
<td>1108.02</td>
<td>292.74</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CUKT010</td>
<td>649.87</td>
<td>171.70</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1¼</td>
<td>CUKT012</td>
<td>422.03</td>
<td>106.43</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1½</td>
<td>CUKT015</td>
<td>281.43</td>
<td>74.35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CUKT020</td>
<td>136.02</td>
<td>35.94</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

COPPER TEES FITTING ON COPPER PIPE SCH L

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
<tbody>
<tr>
<td>½</td>
<td>CUKT005</td>
<td>2406.30</td>
<td>635.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>¾</td>
<td>CUKT007</td>
<td>1174.77</td>
<td>310.37</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CUKT010</td>
<td>672.28</td>
<td>177.62</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1¼</td>
<td>CUKT012</td>
<td>402.84</td>
<td>106.43</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1½</td>
<td>CUKT015</td>
<td>294.99</td>
<td>77.94</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CUKT020</td>
<td>149.63</td>
<td>39.53</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

COPPER/BRONZE BRAZOLET ON SCH 40 PIPE

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
<tbody>
<tr>
<td>2½</td>
<td>BR4B025</td>
<td>117.31</td>
<td>30.99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BR4B030</td>
<td>78.62</td>
<td>20.77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>BR4B040</td>
<td>45.13</td>
<td>11.92</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BR4B050</td>
<td>32.79</td>
<td>8.66</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>BR4B060</td>
<td>22.73</td>
<td>6.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>BR4B080</td>
<td>13.14</td>
<td>3.47</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>BR4B100</td>
<td>8.34</td>
<td>2.20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>BR4B120</td>
<td>5.87</td>
<td>1.55</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Iron Saddles

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
</table>
| SCH 80 IRON SADDLE ON SCH 80 PIPE
| 2              | IR8S020      | 194.85   | 51.48   |          |        |
| 2½            | IR8S025      | 142.28   | 37.59   |          |        |
| 3             | IR8S030      | 87.53    | 23.13   |          |        |
| 4             | IR8S040      | 40.62    | 10.73   |          |        |
| 5             | IR8S050      | 29.28    | 7.74    |          |        |
| 6             | IR8S060      | 22.30    | 5.89    |          |        |
| 8             | IR8S080      | 12.52    | 3.31    |          |        |
| 10            | IR8S100      | 7.94     | 2.10    |          |        |
| 12            | IR8S120      | 5.65     | 1.49    |          |        |

SCH 80 IRON SADDLE ON SCH 40 PIPE

<table>
<thead>
<tr>
<th>Pipe Size (In.)</th>
<th>Fitting Type</th>
<th>K-Factor</th>
<th>Gallons</th>
<th>K-Factor</th>
<th>Liters</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>IR8S020</td>
<td>185.35</td>
<td>48.97</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2½</td>
<td>IR8S025</td>
<td>127.47</td>
<td>33.68</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>IR8S030</td>
<td>76.62</td>
<td>20.24</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>IR8S040</td>
<td>40.23</td>
<td>10.63</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>IR8S050</td>
<td>27.32</td>
<td>7.22</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>IR8S060</td>
<td>19.71</td>
<td>5.21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>IR8S080</td>
<td>11.61</td>
<td>3.07</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>IR8S100</td>
<td>7.36</td>
<td>1.94</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>IR8S120</td>
<td>5.18</td>
<td>1.37</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8. Calibration Menu

The K-Factors published in this manual assume that the flow conditions in the pipe are ideal. Many factors that affect the flow rate are beyond the control of the magmeter; variations in actual pipe dimensions, pipe smoothness, and other flow conditions will contribute to the total system error. Performing a custom calibration with the magmeter in place will adjust the K-Factor and can serve to compensate for installation conditions that may be less than ideal. Select one of the calibration methods in this menu to achieve the most accurate measurement possible in a specific application.

NOTE: The Security Code must be entered before selecting the calibration method.

8.1 Volume Method of Calibration

Use the volume method of calibration if the fluid passing the magmeter can be measured by a volumetric method (as in a vessel of known volume, or by weight). It requires the ability to pump a known volume of water past the magmeter, and then input the volume into the 2551 program. It is most useful for small pipes and lower flow rates.

When performed properly, volumetric calibration is the most accurate method. For best results a five minute test period is recommended, and the test period should be no less than two minutes.

At START, the 2551 begins counting the flow past the sensor.

At STOP, the 2551 stores the total flow accumulated since the START.

Enter the VOLUME that has been pumped past the sensor.

This error message appears if volume entered or the accumulated flow is zero. Repeat the test after checking the system.

This message appears if the new K-Factor is less than 0.0001 or greater than 999999. To correct the problem, perform the volumetric flow again, and be certain that the volume entered is accurate.

Using the information from the VOLUME method, the 2551 will recalculate a new K-Factor. Press ENTER to accept the new value, or use the keypad to adjust the value.

8.2 Rate Method of Calibration

Use this method if the 2551 Magmeter must be calibrated to match a reference flow meter. This is the method most commonly used by monitoring agencies, and for large pipes where volumetric calibration is impractical. The accuracy of this calibration method is largely dependent on the accuracy of the reference meter and the proximity of the reference to the Signet 2551 Magmeter.

The flow rate shown is based on the existing calibration of the 2551. Use the keypad to modify the flow rate to match the reference meter. The 2551 will automatically calculate a new K-Factor based on the new flow rate.

This message appears if the new K-Factor is less than 0.0001 or greater than 999999. To correct the problem, reexamine the flow rate and make certain it is accurate.

Using the information from the RATE MATCHING method, the 2551 will recalculate a new K-Factor. Press ENTER to accept the new value, or use the keypad to adjust the value.
9. Relay Menus

Magmeter models 3-2551-21 and -22 have two dry contact relays (Relays 1 and 2) and one Solid State relay (Relay 3).

Any of these relays can be set to any of the operating modes listed below.

The setpoint values for HIGH, LOW and WINDOW modes can be set to negative values if required. For example, a LOW alarm might be set to activate if the flow rate falls below -10 GPM.

Negative values are not available for relays in PULSE or TOTAL modes.

Off: If a relay is not used, it can be turned Off to prevent contact wear.

**NOTE:** The Security Code must be entered before modifying the relay menu.

9.1 Pulse Relay mode

Program a relay to activate for a fixed period, for each volume of fluid that passes the sensor.

For example, program the relay to pulse once for 100 ms for every 3 gallons that pass by the sensor.

**Relay 1 Mode**

- **Pulse**
  - **Relay 1 Width**
    - 0.1 secs
  - **Relay 1 Volume**
    - 0.0000 Gal

**Relay Volume:** Set the volume of fluid that the 2551 must measure before activating the relay for one pulse.

**Pulse Width:** Adjust the length of time the relay will remain activated. The pulse width setting is dependent on the type of external equipment being connected to the relay.

9.2 Total Relay mode

Program a relay to activate when the Resetable totalizer reaches a specific value. The maximum setting is 999999.

Application example: A filter must be replaced in an R.O. system every 10000 gallons. The service representative that installs a new filter sets relay 3 to Total mode, sets the setpoint at 10000 and resets the totalizer to 000000.00. Every time the Totalizer reaches 10000, the relay activates and lights a message indicator to remind the service representative to replace the filter.

When the totalizer is reset, the relay will be deactivated and the process begins anew.
9.3 High, Low, or Window Relay modes
Program the relay to activate when the flow rate reaches a setpoint (High or Low) or when the flow rate moves outside of a prescribed range (Window).

Reverse Flow
The setpoint values for HIGH, LOW and WINDOW modes can be set to negative values if required. For example, a LOW alarm might be set to activate if the flow rate falls to -10 GPM.

- **Set Low**: Set the flow rate where a Low relay will be activated.
- **Hysteresis**: Set a flow rate increment where the relay will be deactivated. The hysteresis setting serves to prevent relay "chatter" when the flow rate recovers from an alarm condition by requiring the low rate to move substantially within the setpoint.

- **Set High**: Set the flow rate where a High relay will be activated.
- **Delay**: Set a time period for the relay to wait after reaching the setpoint. This delay serves to prevent the relay "chatter" by allowing the flow rate time to move back within the setpoint.

The values shown for each menu item represent the factory standard setting. All 2551 magmeters are packaged with these settings.
The Options Menu contains those features and settings that will normally be set one time and then seldom changed. These include language preference, decimal placement, Security Code assignment, etc.

- **Language**: Select from English, French, German, Italian, Portuguese or Spanish. This selection will be displayed at first power-up of a new magmeter.

- **Security Code**: Can be set to any four digit number. Factory standard setting is 0000.

- **Contrast**: Set for best view after the magmeter is installed. Larger number means display appears darker.

- **Total Reset**: Lock ON requires the Security Code before resetting the Resetable Totalizer. Lock OFF reset with no security code.

- **Noise Rejection**: Filters out common 50 or 60 Hz electrical noise.

- **Flow Decimal**: Set the maximum resolution for the FLOW RATE display by limiting the decimal to this point. The Flow Rate display will auto-scale from this resolution up to whole units.

- **Total Decimal**: Set the maximum resolution for the TOTALIZER display by limiting the decimal to this point. The Totalizer display will always show this resolution.

- **Separator**: Select decimal point or comma for use in numeric displays.

- **Output Mode**: For Frequency/Digital models only: Select Freq output, Freq ÷ 10 output, Mirror Relay 1 output or S3L Digital output.

### 11.1 Output Modes

In **FREQUENCY** output mode, the 2551 serves as a traditional flow sensor and provides an output pulse that is compatible with all Signet POWERED flow instruments. It is not compatible with the 5090 Self-Powered Flow Meter or the 8150-1 Battery-Powered Flow Totalizer. The frequency output range is from 0 Hz to 1000 Hz.

The **FREQUENCY ÷ 10** output mode reduces the output frequency of the 2551 to a range that is useful for some programmable logic controllers (PLC). The frequency output range is from 0 Hz to 100 Hz. This shift does not affect the stated accuracy of the 2551 Magmeter’s frequency output.

The **MIRROR RELAY 1** output mode allows 2551 Frequency/Digital models to use the Open Collector Output like a relay that can be programmed via the Relay 1 menu.

If the magmeter is equipped with relays, this mode will mirror the settings of Relay 1.

If the magmeter is not equipped with relays, this mode can still be selected and programmed via the Relay 1 menu.

The **S3L Digital** output mode switches the 2551 to the Signet serial data output called S3L (Signet Serial Sensor Link). In this mode the 2551 can be added to the serial bus of the Signet 8900 Multi-Parameter Controller or 9900 Transmitter.
12. Technical Information

12.1 Grounding
Precalibration conditioning: The magmeter may appear to be unstable immediately after installation. Allow the sensor to sit in a full pipe for 24 hours before beginning calibration and operation.
- Use a cable gland or a liquid tight connector to seal the cable ports from water intrusion.
- Use PTFE tape or a suitable sealant on cable ports.
- The 2551 magmeter must be carefully grounded to eliminate electrical noise that may interfere with the measurement.
- Grounding requirements will vary with each installation.
- The following recommendations should be applied in sequence until the interference is eliminated.

1. The ground terminal on the outside of the yellow housing is connected internally to the grounding ring at the tip of the sensor. Connect a conductor (14 AWG/1.5 mm² wire recommended) from this terminal directly to Earth ground to prevent electrical noise from interfering with the magmeter signal.

If the interference persists, apply step #2:

2. Connect grounding rings, metal clamps or grounding electrodes to the pipe immediately upstream and downstream of the magmeter sensor location. These devices must be in contact with the fluid.

If the interference persists, apply step #3:

3. The shield from the output cable must be terminated at the remote instrument ONLY. This shield must not be connected at both ends!

If the interference persists, apply step #4:

4. Connect an additional wire (minimum AWG 14/1.5 mm²) from the remote instrument ground to the magmeter ground terminal.

12.2 Maintenance
The 2551 Magmeter requires very little maintenance. There are no user-serviceable components in the magmeter.

- If the fluid contains deposits and solids that may coat the electrodes, a regular cleaning regimen is recommended.
- Do not use abrasive materials on the metal electrodes. Clean with soft cloth and mild detergent only.
- Use a cotton swab and mild detergent to remove deposits on the metal electrodes.

Environmental Recommendations:
- When used properly, this product presents no inherent danger to the environment.
- Please follow local ordinance when disposing of this or any product with electronic components.
12.3 Troubleshooting

### Symptom | Possible Cause | Solution
--- | --- | ---
Output is erratic and unstable. | Magmeter installed too close to upstream obstruction. | Relocate the magmeter to have straight uninterrupted pipe upstream of the sensor for at least 10 x the pipe diameter. |
 | Magmeter located in area exposed to air bubbles/pockets. | Eliminate air bubbles in the pipe. |
 | Magmeter is installed in pipe backwards. | Remove the magmeter and reinstall with the flow direction arrow on the sensor body pointed DOWNSTREAM. |
 | Electrical noise is interfering with the measurement. | Review the grounding of the magmeter and the pipe. Install adequate Earth ground to allow the Magmeter to operate properly. |
 | Electrodes are coated with deposits or chemical oxide layers. | Carefully clean the electrodes. Refer to sensor manual for details. |
Output is not 0 when flow is stopped. | Electrodes not adequately conditioned in fluid. | Allow the sensor to sit in full pipe for 24 hours then restart. |
 | Fluid is moving inside the pipe. | Increase the Low Flow Cutoff. (section 7.0) |
No 4 to 20 mA output. | Loop power not connected correctly. | Connect 24 VDC ±10% connected to loop terminals 1 and 3. |
4 to 20 mA current output is incorrect. | 4-20 mA is not scaled properly. | Check and reset in the Setup Menu. |
No Frequency output. | 2551 is wrong model. | Frequency/S3'L model: 3-2551-21 (w/rlys) or -41 (w/o rlys). |
No S3'L output. | Incorrect setting in Options Menu. | Select Frequency in the Options menu. |
 | Wiring is not correct. | Check wiring, make corrections. |
 | Frequency input to other manufacturer’s flow instrument does not have pull-up resistor. | Install 10 kΩ resistor. (section 5.1) |
No flow rate, current output is 22 mA. | The fluid is too clean for Magmeter. | Unsuitable application for Magmeter. |
 | Electronic component failure. | Return 2551 to factory. |
Blank display, no backlighting, no relay LEDs, but external equipment using output signal is still working. | 2551 AUX power is not connected. | Connect AUX power (section 5.5) (9 to 24 VDC, 0.4 A max.) |
Error Message: "Error Not Saved" | Main power is below specification. | Correct the main power deficiency. |

### Troubleshooting with the RED and BLUE LEDs

#### No Lights: The power is off or the sensor is not connected
#### Solid Blue: The power is on but there is no flow in the pipe.
#### Blinking Blue: Normal operation, blink rate is proportional to the flow rate.
#### Alternating Red-Blue: Empty pipe indication (electrodes are not wet.)
#### Blinking Red: System errors (Electrical noise interference)
#### Solid Red: Instrument error (defective electronic component)

### Reverse flow:
- Frequency out cannot distinguish reverse flow from forward flow. The output will be the absolute value.
- Digital (S3'L) output: Reverse flow results in 0 flow rate displayed on 8900, or with negative numbers on the 9900.
- 4 to 20 mA output can be spanned into negative flow range using the custom setup tool. (example: 4-20 mA = -100 to +100 GPM)

### Empty Pipe Detection
- Frequency output will be locked to 0 Hz if electrodes are not wet.
- Digital (S3'L) output will be locked to 0 if electrodes are not wet.
- 4-20 mA will be locked to 4 mA if electrodes are not wet.
- Blue and Red LED indicators on the magmeter circuit will blink alternately if the electrodes are not wet.
13. Ordering Information

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3-2551-P0-21</td>
<td>159 001 267</td>
<td>3-2551-T2-21</td>
<td>159 001 454</td>
</tr>
<tr>
<td>3-2551-P0-22</td>
<td>159 001 273</td>
<td>3-2551-T2-22</td>
<td>159 001 455</td>
</tr>
<tr>
<td>3-2551-P0-41</td>
<td>159 001 261</td>
<td>3-2551-T2-41</td>
<td>159 001 460</td>
</tr>
<tr>
<td>3-2551-P0-42</td>
<td>159 001 279</td>
<td>3-2551-T2-42</td>
<td>159 001 461</td>
</tr>
<tr>
<td>3-2551-P1-21</td>
<td>159 001 268</td>
<td>3-2551-V0-21</td>
<td>159 001 269</td>
</tr>
<tr>
<td>3-2551-P1-22</td>
<td>159 001 274</td>
<td>3-2551-V0-22</td>
<td>159 001 275</td>
</tr>
<tr>
<td>3-2551-P1-41</td>
<td>159 001 262</td>
<td>3-2551-V0-41</td>
<td>159 001 263</td>
</tr>
<tr>
<td>3-2551-P1-42</td>
<td>159 001 280</td>
<td>3-2551-V0-42</td>
<td>159 001 281</td>
</tr>
<tr>
<td>3-2551-P2-21</td>
<td>159 001 435</td>
<td>3-2551-V1-21</td>
<td>159 001 270</td>
</tr>
<tr>
<td>3-2551-P2-22</td>
<td>159 001 438</td>
<td>3-2551-V1-22</td>
<td>159 001 276</td>
</tr>
<tr>
<td>3-2551-P2-41</td>
<td>159 001 432</td>
<td>3-2551-V1-41</td>
<td>159 001 264</td>
</tr>
<tr>
<td>3-2551-P2-42</td>
<td>159 001 441</td>
<td>3-2551-V1-42</td>
<td>159 001 282</td>
</tr>
<tr>
<td>3-2551-T0-21</td>
<td>159 001 436</td>
<td>3-2551-V2-21</td>
<td>159 001 456</td>
</tr>
<tr>
<td>3-2551-T0-22</td>
<td>159 001 439</td>
<td>3-2551-V2-22</td>
<td>159 001 457</td>
</tr>
<tr>
<td>3-2551-T0-41</td>
<td>159 001 433</td>
<td>3-2551-V2-41</td>
<td>159 001 462</td>
</tr>
<tr>
<td>3-2551-T0-42</td>
<td>159 001 442</td>
<td>3-2551-V2-42</td>
<td>159 001 463</td>
</tr>
<tr>
<td>3-2551-T1-21</td>
<td>159 001 437</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3-2551-T1-22</td>
<td>159 001 440</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3-2551-T1-41</td>
<td>159 001 434</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3-2551-T1-42</td>
<td>159 001 443</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Replacement Parts and Accessories

<table>
<thead>
<tr>
<th>Mfr. Part No.</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1220-0021</td>
<td>198 801 186</td>
<td>O-ring, FPM</td>
</tr>
<tr>
<td>1224-0021</td>
<td>198 820 006</td>
<td>O-ring, EPDM</td>
</tr>
<tr>
<td>1228-0021</td>
<td>198 820 007</td>
<td>O-ring, FFPMP</td>
</tr>
<tr>
<td>3-8050.390-1</td>
<td>159 001 702</td>
<td>Retaining Nut Replacement Kit, NPT, Valox®</td>
</tr>
<tr>
<td>3-8050.390-3</td>
<td>159 310 116</td>
<td>Retaining Nut Replacement Kit, NPT, PP</td>
</tr>
<tr>
<td>3-8050.390-4</td>
<td>159 310 117</td>
<td>Retaining Nut Replacement Kit, NPT, PVDF</td>
</tr>
<tr>
<td>3-8050.391</td>
<td>159 001 703</td>
<td>Retaining Nut Replacement Kit, NPT, Stainless Steel</td>
</tr>
<tr>
<td>3-8050.396</td>
<td>159 000 617</td>
<td>RC Filter kit (for relay protection)</td>
</tr>
<tr>
<td>3-8551.521</td>
<td>159 001 378</td>
<td>Clear plastic cap for display</td>
</tr>
</tbody>
</table>